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1. Introduction to ArcStereoNet 

ArcStereoNet (ASN) is an ArcGIS® Python-toolbox whose main features include the projection and 
the analysis of oriented data, mainly for structural geology and mineralogy purposes. Oriented data 
can be acquired on field (e.g. beddings, fault lines etc.) by means of classic geologist instruments like 
compass but also extracted from thin section high-resolution images (e.g. mineral preferred 
orientations). However, ASN is potentially suitable to work with any type of oriented data. 

ASN can be installed on ArcGIS® 10.3+ versions (see Installation for details) and it is devised for 
working on ArcMap®. This allows the user to take advantage of the powerful geospatial analysis 
functions provided by ArcGIS®, minding the gap between spatial orientation of data and their 
georeferenced positions. 

The available tools within the ArcStereoNet Python-toolbox are: Stereoplots tool (for stereographic 
projections and oriented data analysis), Rose Diagrams tool (for rose histograms creation) and Graph 
To Hyperlink tool (to link plots with the corresponding geographic position in map). 

1.1 Requirements 

ArcStereoNet requires any working ArcMap® version ≥ 10.3 to be installed on a Windows® operative 
system (XP, Vista, 7, 8, 8.1, 10). NB: ArcMap® 10.3 pre-release version is not supported. 

  



2. Installation 

ASN core Python library, mplstereonet (Kington, 2016), gathers all the main functions to generate 
stereographic projections. Such library does not come with the default installation of Python 2.7.x 
for ArcGIS®, therefore it must be specifically installed for ASN to work. The most canonical way to 
carry out the installation is by mean of pip (i.e. the most known Package Installer for Python). The 
toolbox has been programmed to fully automate this procedure. If your ArcMap® version is 10.3 or 
10.3.1, please follow the instructions at Installation with ArcMap® 10.3 section before reading on.  

The user must copy the file “ArcStereoNet.pyt” inside ArcGIS® toolboxes folder. By default, the full 
path is: “C:/Program Files (x86)/ArcGis/Desktop10.x/ArcToolbox/Toolboxes”. Once the file is 
copied, the user can open the ArcToolbox window inside ArcMap®, right-click and then select “Add 
Toolbox” option to import ASN.  

The installation will automatically start; this requires an internet connection. A pop-up window will 
inform the user whether the components have been successfully installed or not.  

[Kington, J. (2016). Mplstereonet. Available at https://github.com/joferkington/mplstereonet]. 

2.1 Installation with ArcMap® 10.3 

By default, ArcGIS® 10.3 and 10.3.1 versions do not include pip in their Python directory, therefore, it 
needs to be installed manually.  To achieve this, go to https://bootstrap.pypa.io/get-pip.py, right-
click and select “Save As” to download the “get-pip.py” script on your computer. The file must be 
saved in the Scripts directory, which is located by default in “C:\Python27\ArcGIS10.3\Scripts”. 
Then, follow the installation steps described above. If, for any reason, the automatic installation 
routine happens to fail, refer to the manual installation of pip at https://pip.pypa.io/en/stable/. 

  



3. Getting started 

In order to launch ASN tools, an ESRI shapefile storing oriented data is needed. It can be created 
directly inside ArcMap® through the “Create Feature” window, but a tabular data file that contains 
two columns storing latitude and longitude coordinates can also be imported and then converted 
into a shapefile. This can be performed through the following steps: 

1. Click on File > Add Data > Add XY Data (a) and select the tabular data sheet and the 
coordinates fields (b) The coordinate system can also be here specified. 

  

(a) (b) 



2. In the Table of Contents, right-click on the imported file, then select Data > Export Data (c) 
and choose an output path for the new shapefile (d).   

 

For more information please refer to ESRI official guidelines here. 

(c) 

(d) 



3.1 Fields formatting 

ASN tools require as input the following information: 

 Azimuth angle (both Stereoplots tool and Rose Diagrams tool) 
 Dip angle (only Stereoplots tool) 
 Sampling method (only Stereoplots tool) 
 Feature type (both Stereoplots tool and Rose Diagrams tool) 

These must be stored in different fields within the attribute table of the oriented data shapefile. ASN 
tools can automatically fill the required inputs if such fields are renamed as follows (not case 
sensitive): 

 Azimuth – here azimuthal values (i.e. direction, dip direction or trend) shall be stored as 
numeric values. 

 Dip Angle or Dip_Angle – here inclination values (i.e. dip or plunge) shall be stored as 
numeric values. 

 Method – here the data format must be specified as text values, choosing from “RHR”, “DD” 
and “TP” (must be written in uppercases), indicating, respectively, the following 
conventional sampling methods: Right Hand Rule, Dip Direction/Dip and Trend-Plunge.  

 Type – here the user should indicate the feature type as text values (e.g. “Main Foliation”). 
Such information is not mandatory, though highly recommended. It is functional for the 
legend labels but also guides the toolbox to a correct grouping and graphical representation 
of the different types of data. 

The user can also populate with such information a tabular data file and then import it, as described 
in Getting started section; each column will be treated as a different field by ArcMap®. The attribute 
table can also be edited at any time. If the fields are not renamed as suggested above, it is still possible 
to select manually the corresponding ones within the tools interface (see Tools for details). Other 
fields can also be added in the attribute table according to user’s needs and preferences. 

  



4. Tools 

Once the oriented data shapefile has been created, any ASN tool can be launched. The Stereoplot tool 
is useful to obtain lower hemisphere stereographic projections, showing cyclographic traces and 
poles for the selected planar measurements and points for the linear ones. Several contouring and 
statistical functions can also be applied on oriented data. The Rose Diagrams tool can be chosen to 
create weighted and unweighted rose diagrams and to extract mean vectors directions. Finally, the 
Graph To Hyperlink tool allows to link realised graphs to the georeferenced position of plotted data. 

4.1 Stereoplots tool 

The following screenshots illustrate the Stereoplots tool layout. A detailed description for each 
parameter is provided below. Green dots indicate required parameters. 



a) Oriented dataset input parameter. A shapefile is required: point, line and polygon feature 
types are supported. If the user has selected some features, the tool will not consider the 
unselected ones. Otherwise, all data stored within the oriented data shapefile will be taken 
into account. 

b) Azimuth, Dip Angle, Method and Type fields input parameters. If the user has formatted the 
shapefile fields names as recommended (see Getting started), these parameters will be 
automatically filled, otherwise they can be selected manually through the drop-down 
menus. 

c) Plotting data Value Table. The feature types can be added through the drop-down menu. 
For each feature type, the user can specify the plotting colour, pole or vector symbol and 
size, cyclographic trace style and width (Value Table columns). If a linear datatype is added, 
the corresponding cyclographic trace style and width entries will be ignored by the tool. A 
linear datatype is automatically identified by checking the Method field.  

d) Output image settings. By unchecking the “Store Image Output” checkbox, the user can 
prompt the tool to save a temporary output image file and automatically open it after the 
tool execution. Otherwise, the output image file path can be specified in the “Output Image” 
parameter box. The DPI value can be set through the parameter below.  

e) Contour & Statistics sub-menu (collapsed). See Contour & Statistics for details.  
f) Plot customisation sub-menu (expanded). The following parameters can be set (from top to 

bottom): the title label that will appear in the final plot (if not specified, it will be the name 
of the shapefile); the number of tick marks surrounding the plot and their type (i.e. angular 
values, cardinal points or a mix of them); whether to enable or disable the appearance of the 
stereonet grid, the legend and the number of plotted data.   

g) Plotting options sub-menu (expanded). The stereonet type can be chosen between equal-
area (Schmidt net) and equal-angle (Wulff net). The “Write Log File” option can be checked 
to prompt the tool to compile a text file storing statistical information concerning the plotted 
data and the functions applied on it. If the “Store Image Output” option (d) is not enabled, 
a temporary log file will be created and automatically opened together with the image. 
Otherwise, the log file will be saved in the same output directory selected for the image.  

4.1.1 Contour & Statistics 

Expanded Contour & Statistics sub-menu of Stereoplots tool. 



a) “Apply Contour” Value Table. The feature types can be added through the drop-down 
menu. The user can choose the preferred contour density function under the “Method” 
column, but she/he can also set other parameters such as standard deviation, style (“filled” 
or “unfilled”), colour and transparency of the contour through the corresponding columns.  
Tip: A warning message will pop-up if two or more contour functions are applied 
contemporaneously. However, it is still possible for the users to prompt for multiple contour 
functions if they really want to. An “unfilled” contour style is recommended.  

b) Show a colour bar referred to the applied contour. This setting will be enabled after the 
“Apply Contour” Value Table has been populated. If two or more contours are applied at 
the same time, the colour bar will be referred to the last one.  

c) “Extract Mean Vectors” Value Table. The feature types can be added through the drop-down 
menu. Multiple feature types can be analysed contemporaneously, and the same feature type 
can be analysed with different algorithms as well. Under the “Algorithm” column the 
preferred algorithm can be chosen. The choices are: M.E.A.D., M.E.A.D. + Fisher, K-means, 
Bingham.  

 The M.E.A.D. algorithm can be used for a fully user-controlled clustering extraction, 
thanks to the azimuth and inclination tolerances parameters.  

 The M.E.A.D. + Fisher algorithm adds to the previous one the extraction of Fisher 
statistics (mean vector magnitude, confidence radius and dispersion factor – Fisher et 
al., 1993) that will be stored into the log file (if prompted by the user). A confidence 
cone surrounding the pole to extracted mean plane will also be plotted.  

 The K-means algorithm employs a k-means approach (MacQueen, 1967) modified for 
spherical data.  

 The Bingham algorithm allows to extract the best fit plane of a “girdle-like” 
distribution pattern (Bingham, 1974) of poles to planes or lines.  

The algorithm-control parameters can be set through the following columns (from left to 
right): “Number of Clusters”, to specify the number of families to split data into; “M.E.A.D. 
Azimuth tolerance” and “M.E.A.D. Inclination tolerance”, to constrain the algorithm to 
define more or less dispersed clusters; “Fisher confidence”, that influences the Fisher 
confidence radius computed by M.E.A.D. + Fisher algorithm. Each of these control 
parameters affects only some of the algorithms as summarised in the following table.  

 M.E.A.D. + Fisher M.E.A.D. K-means Bingham 
Number of Clusters X X X - 

M.E.A.D. Azimuth tolerance X X - - 
M.E.A.D. Inclination tolerance X X - - 

Fisher Confidence X - - - 
 
If a not affecting parameter is specified, it will simply be skipped by the tool.  
The next columns within the Value Table gather graphic-related parameters such as plotting 
colour, pole or vector symbol and size, cyclographic trace style and width. If a linear datatype 
is added, the corresponding cyclographic trace style and width entries will be ignored by the 
tool. A linear datatype is automatically identified by checking the Method field. 
Tip: If the user is uncertain on the number of clusters to insert, a possible workaround is to 
prompt for a high number (e.g. 20 or more). In such a way the algorithms affected from the 
“Number of Clusters” parameter will extract the highest number of plausible clusters (which 
are likely less than 20+). 



d) Track M.E.A.D. clustering behaviour. This option will be enabled after the “Extract Mean 
Vectors” Value Table has been populated and will only apply on clusters extracted through 
the M.E.A.D. clustering process (M.E.A.D. and M.E.A.D. + Fisher algorithms). If checked, the 
tool will plot the clustered data with different symbols for each extracted cluster. The users 
can take advantage of this option to identify the M.E.A.D. tolerance parameters best suited 
to their preferences and needs. 

Tip: It is likely that the users will test the ASN algorithms several times, modifying the control 
parameters repeatedly, until finding the ones that better suit their preferences and needs. During 
this phase (testing phase), we highly recommend using the ArcMap® “Results” window to recall any 
previously launched tool. In such a way the user can quickly modify only the desired parameter 
without having to set all the others each time. We also recommend deselecting the "Store Image 
Output" option during the testing phase, in order to rapidly view the graphic result and save 
memory space on the disk. 

[Bingham, C. (1974). An antipodally symmetric distribution on the sphere. The Annals of Statistics, 
1201-1225]. 

[Fisher, N. I., Lewis, T., & Embleton, B. J. (1993). Statistical analysis of spherical data. Cambridge 
university press]. 

[MacQueen, J. (1967). Some methods for classification and analysis of multivariate observations. In 
Proceedings of the fifth Berkeley symposium on mathematical statistics and probability (Vol. 1, 
No. 14, pp. 281-297)].  

Influence of Azimuth and Inclination tolerance parameters on M.E.A.D. clustering process, highlighted by the "Track 
M.E.A.D. behaviour" option. 



4.2 Rose Diagrams tool 

The following screenshot illustrate the Rose Diagrams tool layout. A detailed description for each 
parameter is provided below. Green dots indicate required parameters. 

a) Oriented dataset input parameter. A shapefile is required: point, line and polygon feature 
types are supported. If the user has selected some features, the tool will not consider the 
unselected ones. Otherwise, all data stored within the oriented data shapefile will be taken 
into account. 

b) Azimuth and Type fields input parameters. If the user has formatted the shapefile fields names 
as recommended (see Getting started), these parameters will be automatically filled, 
otherwise they can be selected manually through the drop-down menus. 



c) Plotting data Value Table. The feature types can be added through the drop-down menu. For 
each feature, the user can specify the bar colour and whether to show the mean vectors or 
not, with a determined number of clusters and azimuth tolerance (Value Table columns).  

d) Output image settings. By unchecking the “Store Image Output” checkbox, the user can 
prompt the tool to save a temporary output image file and automatically open it after the 
tool execution. Otherwise, the output image file path can be specified in the “Output Image” 
parameter box. The DPI value can be set through the parameter below.   

e) Plot customisation sub-menu (expanded). The following parameters can be set (from top to 
bottom): the title label that will appear in the final plot (if not specified, it will be the name 
of the shapefile); whether to enable or disable the appearance of the polar grid, the legend, 
and the number of plotted data; the spacing (in degrees) of the tick marks surrounding the 
diagram; the orientation of the radial scale (in degrees from N); the grid spacing (i.e. spacing 
of the radial scale). 

f) Plotting options sub-menu (expanded). If the “Mirrored behaviour” option is checked a 
specular rose diagram will be generated. A warning message will popup if the azimuthal 
dataset spreads for more than 180°. If the “Weighted Rose Diagram” option is selected, the 
below “Weight Field” parameter enables and must be filled with a field of the input shapefile 
storing weight data. A warning message will appear if one or more weights are negative 
values. The “Write Log File” option can be checked to prompt the tool to compile a text file 
storing statistical information concerning the plotted data. If the “Store Image Output” 
option (d) is not enabled, a temporary log file will be created and automatically opened 
together with the image. Otherwise, the log file will be saved in the same output directory 
selected for the image. 

  

Example of a radial scale oriented 0° and with a 
spacing of 8 (default values). 



4.3 Graph To Hyperlink tool 

The following screenshot illustrate the Graph To Hyperlink tool layout. All parameters are here 
required. 

 The Input Plot Images parameter requires one or more raster images to be provided. The files 
can be selected through the drop-down menu. Such images are meant to be the plots 
resulting from the application of the Stereoplots and/or the Rose Diagrams tool. Each time a 
new stereoplot or rose diagram is saved as a PNG image, a text file (named as 
“imageName_xy.txt”) is automatically compiled and stored in the same output directory. 
Such file contains the spatial information referred to the corresponding plot. Make sure to 
not delete or move these files, as they are required by the Graph To Hyperlink tool to link each 
image to the correct georeferenced position. If the user selects an image whose _xy.txt file is 
missing, an error message will popup.  

 The output file path can be chosen through the Output Feature Class parameter. A new point 
shapefile, gathering all the links to the selected images and their corresponding latitude and 
longitude values, will be created.    

The spatial information attached to each plot is computed as the mean latitude and the mean 
longitude (centroid) of the processed data. Please note that if the user does not operate any 
selection of data before running the Stereoplots or the Rose Diagrams tool, all dataset will be 
considered during the computation. The adopted reference system will be the same as the dataset 
from which the plots were extracted.  



Once the Graph To Hyperlink tool has been executed and the new resulting shapefile imported within 
ArcMap®, the user can enable the hyperlink or the HTML popup view. This can be done by right-
clicking on the new shapefile and selecting the Properties option (a).  

Under the Display tab, enable the “Support Hyperlinks using field” option (b), then select the “Plot” 
field and check the “Document” option to allow hyperlinks. Otherwise, enable the “Show content 
for this layer using the HTML Popup tool” option (c) under the HTML Popup tab, then specify to 
display HTML formatting as a URL and select the “Plot” field to allow HTML popup view. 

If hyperlinks are allowed (b), each feature of the new shapefile created with the Graph To Hyperlink 
tool can be clicked on map and the corresponding image will be opened with your default image 
viewer. If HTML popups are allowed (c), plots will pop up directly on map at their corresponding 
georeferenced positions. Both functionalities can be triggered by selecting the related button on the 
Tools toolbar (d). 

(a) 

(b) (c) 



The following screenshot shows an example of HTML popups displaying georeferenced stereoplots 
on map. Tip: Ctrl + mouse wheel to zoom in and out the popup images. 

For more information about hyperlinks and HTML popups in ArcGIS®, refer to ESRI official guides 
here and here, respectively. 

  

(d) 



5. Troubleshooting 

This section lists known errors and bugs that can occur while installing and using ASN, along with 
the possible workarounds.  

5.1 Installation issues 

ASN can sometimes report an installation error with the following pop up message: 

This type of error can be triggered for several reasons. The most common causes are here listed: 

 No internet connection. Your device must be connected to the internet to download the ASN 
external Python packages. 

 Not supported ArcGIS® version; in this case the installation error message is preceded by the 
following version error popup. See Requirements for further details on supported versions.  

 Missing “get-pip.py” file. Users running ASN on ArcMap® 10.3 and 10.3.1 need to install the 
pip package in order to successfully achieve the installation of all ASN required components.  
The pip installation is a semi-automated procedure: the user needs to manually download a 
Python script named “get-pip.py” and save it into the “Script” folder within the Python 
directory (see Installation with ArcMap® 10.3 for further details). If such file is not 
downloaded or stored in the correct directory, a missing get-pip.py error will be reported. 

 



 Other unknown installation issues can be bypassed with a complete manual installation of 
all ASN packages through pip launched by command prompt (follow official PyPA 
guidelines here). The required package is mplstereonet version 0.6.2, but tornado version 4.*  
needs to be prior installed if working with ArcGIS® 10.3 and 10.3.1 versions. 

Tip: If any installation error occurs, before trying again we recommend removing and then re-
adding ASN to ArcToolbox window. 

5.2 Usage issues 

When using ASN tools, some common bugs have been reported: 

 Missing output file extensions when trying to save the output image file on both Stereoplots 
and Rose Diagrams tools. The workaround for this bug is to show the file name extensions 
on your computer as explained here. 

 Tool execution fails when a temporary image is requested ("Store Image Output" option 
deselected, see Tools for details). Such issue may occur because ArcMap® automatically 
imported and showed in the Table of Contents a previous temporary image and, therefore, 
cannot overwrite it. To solve this problem, simply remove the previous temporary image 
from the Table of Content and then re-launch the tool. For a permanent resolution of this 
issue click on Geoprocessing > Geoprocessing Options and uncheck the “Add results of 
geoprocessing operations to the display” option as shown below. 

 Blank image output when a temporary image is requested ("Store Image Output" option 
deselected, see Tools for details). This bug seems to be linked to the default image viewer 
rather than ASN itself. The simple workaround is to re-launch the tool. 



 Microsoft Visual C++ Runtime Library error when closing ArcMap® after a work session 
with ASN.  

This error is caused by a miscommunication between ArcGIS® and the matplotlib Python 
library, but it is totally unharmful for your ArcGIS® software and your computer. At the 
moment the only solution is to simply ignore it; we are trying to find a workaround. 


